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1.  Consumables 

 

Following items are necessary for Protemist® DT II 

 

Style Product name Specification Remarks 

 Package tip, 1,000 ul CellFree Sciences Co., Ltd. 

Catalog No. DIP-1000V-PT24 

96 tips/set 

24 set/case 

 

Reagent pipet 

 Bulk tip, 1,000 ul CellFree Sciences Co., Ltd. 

Catalog No. APS-DIP-1000V 

500 tips/bag 

2 bags/case 

Reagent pipet 

 Reaction cup CellFree Sciences Co., Ltd. 

Catalog No. DT2-P01 

60 cups/case 

For translation and 

purification reaction of 6-ml 

scale 

 Micro tubes 2.0 ml, Type 

I, with skirted base, 

neutral cap 

SARSTEDT 

Catalog No. 72.694.005 

100/bag, 10 bags/case 

Container for template DNA 

of 6-ml scale, transcription 

mixture, translation mixture, 

solution A, and product 

recovery 

 50 ml high-clarity 

Polypropylene conical 

centrifuge tube 

BD-Falcon 

Catalog No. 352070 

25 pieces/bag 

20 bags/case 

Container for translation 

buffer and wash buffer 

 14 ml, 17 x 100 mm 

Polypropylene 

round-bottom test tube 

BD-Falcon 

Catalog No. 352059 

25 pieces/bag 

20 bags/case 

Container for elution buffer, 

resin, and flow through 

fraction 

 PCR strip tubes, 

1 x 8, 0.2 ml 

Greiner-bio-one 

Catalog No. 673210 

125 pieces/bag 

Container for template DNA 

of 1.2-ml scale 

 24-well cell culture plate 

Nontreated polystyrene, 

flat-bottom with lid 

BD-Falcon 

Catalog No. 351147 

50 trays/case 

Container for translation 

reaction of 1.2-ml scale 

 Square bottle, 60 ml Nalge Nunc International 

Catalog No. 2016-0060 

12 pieces/package 

6 packages/case 

Liquid waste bottle 
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2.  Set up the Instrument 

 

 

2-1.  Start up the Instrument and the software 
 

Note: Before one or more hours to set up reagents, turn power on the Instrument and the control PC, then start the 

software so that the Reagent Unit is automatically cooled to and controlled at 4℃. 

 

1. Turn power on the Instrument. 

2. Turn power on the control PC connected to the Instrument. 

3. Double click Protemist DT II icon on the screen to start the software.  Initialization of the Instrument will be 

performed. 

 

 

 

 

 

 

 

 

 

 

 

 

4. User Diagnosis Message window is displayed after the initialization is completed. 

 

 

 

 

 

 

 

5. Click OK in User Diagnosis Message window. 
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2-2.  Perform self diagnosis 
 

1. Select User Diagnosis from Option menu.  User Diagnosis window is displayed. 

 

 

 

 

 

 

 

2. Click OK to begin self diagnosis.  The following window is displayed while self diagnosis is running. 

 

 

 

 

 

 

 

3. Self diagnosis is completed when the following window is displayed. 

 

 

 

 

 

 

 

4. Click OK in the window. 
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2-3.  Set up Reagent Unit and Reaction Unit 
 

Handle the Units and accessories with hand gloves to avoid RNase contamination. 

 

 

Reagent Unit 
 

1. Select Unit Cover Movement in Option menu.  Unit Cover Movement window will be displayed. 

 

 

 

 

 

 

 

 

 

2. Click Open of the Reagent Unit in the Unit Cover Movement window to open the Reagent Unit Cover. 

3. Open the Safety Cover of the Instrument. 

4. Install the Reagent Rack in the Reagent Unit. 

Caution: Ensure the Reagent Rack does not tilt in the Reagent Unit. 

 

 

 

 

 

 

 

 

 

 

 

 

5. Close the Safety Cover of the Instrument. 

6. Click Removal of the Reagent Unit in the Unit Cover Movement window to lift the Reagent Unit Cover. 

7. Open the Safety Cover of the Instrument. 

 

Reagent Rack 

OK 

NG NG NG 

Reagent Rack 

Reagent Unit 
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8. Remove the Reagent Unit Cover by unscrewing two screws on both ends of the Reagent Unit Cover shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

9. Wipe the back of the Cover first with a paper towel infiltrated by RNase decontaminant, and then wipe several 

times with another paper towel infiltrated by nuclease free water. 

 

 

 

 

 

 

 

 

 

10. Replace the Cover to the Reagent Unit and fasten it by turning the screws on both ends of the Cover. 

11. Close the Safety Cover of the Instrument. 

12. Click Close of the Reagent Unit in the Unit Cover Movement window to restore the temperature of the unit at 

4℃. 
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Reaction Unit 
 

1. Close the Safety Cover of the Instrument. 

2. Select Unit Cover Movement in Option menu.  Unit Cover Movement window will be displayed. 

3. Click Removal of the Reaction Unit in the Unit Cover Movement window to lift the Reaction Unit Cover. 

4. Open the Safety Cover of the Instrument. 

5. Remove the Reaction Unit Cover by unscrewing two screws on both ends of the Reaction Unit Cover shown below. 

 

 

 

 

 

 

 

 

 

 

6. Place the Inner Cover for 1.2-ml or 6-ml scale, as the case may be, by unscrewing the screws on the Reaction Unit 

Cover.  The Inner Cover is fastened with three screws for 1.2-ml scale and four screws for 6-ml scale, respectively, 

as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

7. Wipe the surface of the Inner Cover first with a paper towel infiltrated by RNase decontaminant, and then wipe 

several times with a paper towel infiltrated by nuclease free water. 

8. Replace the Reaction Unit Cover to the Reaction Unit and fasten it by turning the screws on both ends of the Cover. 

9. Close the Safety Cover 

10. Click Open of the Reaction Unit in the Unit Cover Movement window. 

 

Inner Cover for 1.2-ml scale Inner Cover for 6-ml scale 



 

9 

 ¨

 

 

11. Install the Reaction Adapter Base for 1.2-ml or 6-ml scale, as the case may be, in the Reaction Unit.  The Reaction 

Adapter Base for 6-ml scale is fastened to the Reaction Unit by turning two screws as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

12. Close the Safety Cover of the Instrument. 

13. Click Close of the Reaction Unit in the Unit Cover Movement window. 

14. Close the Unit Cover Movement window. 

 

Reaction Adapter Base for 

1.2-ml scale 

Reaction Adapter Base for 

6-ml scale 
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2-4.  Select protocol 
 

Seven default protocols are installed in the control PC.  Use the following list to choose an appropriate protocol for your 

purpose. 

 

Translation 

scale 

Protein 

synthesis 
Purification Tag Elution method Protocol name 

1.2 ml Yes No - - 1.2 ml protocol 

6 ml 

Yes No - - 6 ml protocol 

Yes Yes GST 

Reduced glutathione 6 ml protocol@GST 

TEV protease 6 ml protocol@GST_TEV 

PreScission protease 6 ml protocol@GST_PreScission 

Yes Yes His 
Imidazole 6 ml protocol@His_FF 

TEV protease 6 ml protocol@His_TEV_FF 

 

 

1. Select Open in File menu.  Open window will be displayed. 

 

 

 

 

 

 

 

 

 

2. Find the folder that contains the protocol file to be used.  The default protocol files are contained in the folder named 

Master Protocol. 

3. Select the protocol then click Open in the window.  The protocol will be displayed on the screen. 
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4. Select Number of Samples in the pull down list. 

 

 

 

 

 

 

 

 

 

Caution: DO NOT change the parameters that have been present in the columns Collecting Method and Position of 

Reaction Unit. 
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2-5.  Preparation of the reagents 
 

 

Confirm the volume of reagents to be prepared. 
 

1. Select Reagent Settings View from View menu.  Reagent Settings View window will be displayed.  Confirm the kind 

of reagents and their volume to be prepared. 

 

 

 

 

 

 

 

 

 

Note: The names of reagents in the Reagent Preparation Manual are different from those in the Reagent 

Settings View window as shown in the table below.  Please refer to the Reagent Preparation Manual for 

the details of reagent preparation. 

 

Reagent name shown in 

the Reagent Settings View 

Reagent name in Reagent 

Preparation Manual 

Elution buffer I 

Elution buffer B 

Elution buffer C 

Elution buffer F 

Elution buffer II 
Elution buffer D 

Elution buffer G 

Elution buffer III 
Elution buffer A 

Elution buffer E 

 

 

2. Click OK in Reagent Settings View window to close the window. 

3. Prepare the reagents as described in the Reagent Preparation Manual. 

Caution: The volume of each reagent should be equal to or more than them the one indicated in Reagent Settings 

View window.  Otherwise, the Instrument may pause during the process. 
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2-6.  Installation of the reagents and other Items 
 

 

Reagent Unit 
 

1. Click on Run menu, place the pointer on Start/Restart in the Run menu, and select Starting Navigation.  Starting 

Navigation window will be displayed.  If Protocol Save Message window appears, click Yes in the window if you want 

to save the change in the protocol.  Enter a file name if prompted. 

 

 

 

 

 

 

 

 

Note: If changes are made in default protocols, save those protocols with Save As under new file names. 

 

2. Close the Safety Cover of the Instrument. 

3. Select Unit Cover Movement in the Option menu. 

4. Click Open of the Reagent Unit in the Unit Cover Movement window and have the Unit Cover open.  Do the same for 

the Reaction Unit. 

5. Close the Unit Cover Movement window. 
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6. To perform purification, install recovery tubes without caps in the Reagent Unit as indicated in the Starting Navigation 

window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Click Next in the Starting Navigation window. 

8. Remove the caps from the tubes containing reagents and install them in the Reagent Unit as indicated in the Starting 

Navigation window.  Some reagent names that appear in the Starting Navigation window are different from those used 

in the Reagent Preparation Manual.  Use the following table as the cross reference. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Close the Safety Cover of the Instrument. 

10. Select Unit Cover Movement in the Option menu. 

11. Click Close of the Reagent Unit in the Unit Cover Movement window. 

Note: Be sure to close the Cover of the Reagent Unit to keep the reagents at 4℃. 

12. Close the Unit Cover Movement window. 

 

Reagent name in 

Reagent Preparation 

Manual 

Reagent name shown 

in the window 

Position on 

the Reagent 

Rack 

Translation mixture Translation mixture TLM 

Transcription mixture Transcription mixture TCM 

Solution A Solution A SoA 

Translation buffer Translation buffer TLB 

Wash buffer A 
Wash buffer WB 

Wash buffer B 

Elution buffer A 
Elution buffer III 

EB1 

Elution buffer E 

Elution buffer B 

Elution buffer I Elution buffer C 

Elution buffer F 

Elution buffer D 
Elution buffer II EB2 

Elution buffer G 

GST resin GST resin 
RSN 

His resin His resin 

2-ml microtube for 

purified product recovery 

2-ml microtube for 

crude recovery 

14-ml tube for 

flow through recovery 

Reagent Rack in Reagent Unit 

Reagent Rack in Reagent Unit 
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Reaction Unit 
 

Note: Before carrying out the following steps, wipe the Reaction Adapter Cover first with a paper towel infiltrated by 

RNase decontaminant, and then wipe several times with a paper towel infiltrated by nuclease free water. 

 

1. Click Next in the Starting Navigation window. 

2. Close the Safety Cover of the Instrument. 

3. Select Position Motors in the Option menu.  Position Motors window will be displayed. 

 

 

 

 

 

 

 

 

 

4. Click Tilt of the Tilt Motor (A2) in the Position Motors window.  Reaction Unit will be tilted. 

5. Close Position Motors window 

6. Install a 24-well plate for 1.2-ml scale or as many as 6 reaction cups for 6-ml scale in Reaction Unit as indicated in the 

Starting Navigation window. 

 

 

 

 

 

 

 

 

 

 

 

7. Click Next in the Starting Navigation window. 

8. As shown in the Starting Navigation window, install in the Reaction Unit 0.2-ml strip microtubes without caps for 

1.2-ml scale or 2-ml microtubes without caps for 6-ml scale, those micritubes containing template DNA. 

 

 

 

 

 

 

17   18   19    20   21   22   23   24 

 

9    10    11   12   13   14   15   16 

 

1     2     3     4      5     6     7     8 

 

1     2     3     4      5     6 

 

Sample number for 1.2-ml scale Sample number for 6-ml scale 

24-well plate Reaction cups 

Setting the reaction cup 

(vertical section view) 
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9. Close the Safety Cover of the Instrument. 

10. Select Position Motors in the Option menu.  Position Motors window will be displayed. 

11. Click Home of the Tilt Motor (A2) in the Position Motors window.  Reaction Unit will return to home position. 

12. Close Position Motors window. 

13. Install the Reaction Adapter Cover for 1.2-ml or 6-ml scale and tighten the screws on it to fasten the Cover to the 

Reaction Adapter Base in the Reaction Unit. 

 

 

 

 

 

 

 

 

 

 

 

 

14. Close the Safety Cover of the Instrument. 

15. Select Unit Cover Movement in the Option menu. 

16. Click Close of the Reaction Unit in the Unit Cover Movement window to close the Reaction Unit Cover. 

17. Close the Unit Cover Movement window. 

 

 

 

Installation of tips, waste bottle, and dust box 
 

1. Click Next in the Starting Navigation window.  Starting Preview window will appear for final confirmation before 

proceeding further. 

2. As indicated in the Starting Preview window, completely fill the tip rack with tips, install an empty waste bottle, and 

an empty dust box. 

3. Close the Safety Cover of the Instrument. 

 

Reaction Adapter Cover for 

1.2-ml scale 

Reaction Adapter Cover for 

6-ml scale 



 

17 

 ¨

 

2-7.  Start the process 
 

1. Click Go to… in the Starting Preview window.  Time Settings window will be displayed. 

 

 

 

 

 

 

 

 

 

 

2. Enter additional time to modulate the End Time if necessary. 

Note: Modulated End Time will be reflected in the incubation time after the translation step to keep the product 

solution at 4℃.  This function is not available for 1.2-ml scale. 

3. Click Run in the Time Settings window.  Process Start Message window is displayed. 

 

 

 

 

 

 

 

 

 

4. Click Yes in the Process Start Message window to start the process. 
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3.  Pause or Abort the Process 

 

If the process is required to be paused or aborted, follow the procedure shown below. 

 

 

3-1.  Pause the process 
 

1. Click on Pause button in the process monitoring window. 

 

 

 

 

 

 

 

 

2. Pause will be displayed in the status column. 

Caution: The Instrument does not stop right away when the Pause button is clicked on.  Before opening the 

Safety Cover, confirm the Instrument movement is completely stopped. 

 

 

 

 

 

 

 

 

 

 

3-2.  Restart the process 
 

Click on Start/Restart button in the window. 
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3-3.  Abort the process 
 

1. Click on Pause button in the window. 

 

 

 

 

 

 

 

 

 

2. Click on Stop button.  Forced Termination Message window is displayed. 

 

 

 

 

 

 

 

 

 

 

 

3. Click Yes in the Forced Termination Message window to terminate the process.  The Instrument starts 

initialization. 

Caution: Do not open the Safety Cover until the initialization is finished. 

 

4. When the initialization is finished, Process Finish Message window will be displayed. 

 

 

 

 

 

 

 

5. Click OK in the Process Finish Message window. 

 

 



 

20 

 ¨

 

4.  After the Process 

 

 

4-1.  Take out the products 
 

1. Process Finish Message window will be displayed when the process is finished.  As long as the Process Finish 

Message window is displayed, the temperature of the Reaction Unit is maintained at 4℃. 

 

 

 

 

 

 

 

 

2. Click OK in the Process Finish Message window.  The window will be closed.  Take out the products quickly. 

Note: The temperature of the Reaction Unit after OK is clicked on starts to revert to the one set in the 

Temperature Setting window of Temp Setting in the Option menu, while the temperature of the 

Reagent Unit is always controlled at 4℃. 

 

 

 

 

 

 

 

 

 

 

3. Select Unit Cover Movement in the Option menu. 

4. Click Open of the Reagent Unit in the Unit Cover Movement window and have the Unit Cover open.  Do the same 

for the Reaction Unit. 
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1.2-ml translation scale without purification 
 

Synthesized products are in a 24-well plate. 

 

1. Remove Reaction Adapter Cover by loosening two screws. 

2. Carefully take out the 24-well plate containing synthesized products.  Sample numbers on the plate are as shown 

below 

 

 

 

 

 

 

 

 

3. Remove the tubes from the Reagent Unit and Reaction Unit. 

 

 

6-ml translation scale with or without purification 
 

With purification 

 

Purified products are in 2-ml microtubes in the Reagent Unit. 

 

1. Take out the product tubes from the Reagent Unit.  The products are located at the positions shown 

below; 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Remove the Reaction Adapter Cover by loosening two screws. 

3. Take out the tubes from the Reagent Unit and Reaction Unit. 

13   14   15   16    17   18 

 

7     8     9    10    11   12 

 

1     2     3     4      5     6 

 

Sample number in 24-well plate 

19   20   21   22    23   24 

 

2-ml microtube for 

purified product recovery 

2-ml microtube for 

crude recovery 

14-ml tube for 

flow through recovery 
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Without purification 

 

Synthesized products are in reaction cups. 

 

1. Remove Reaction Adapter Cover by loosening two screws. 

2. Carefully take out the reaction cups containing synthesized products. 

 

 

 

 

 

3. Take out the tubes from the Reagent Unit and Reaction Unit. 

1      2       3      4       5      6 

 
Sample number of reaction cups 
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4-2. Post-treatment of accessories 
 

 

Cleaning 
 

Note: Accessories cannot be autoclaved. 

 

1. Remove the Reaction Adapter Base from the Reaction Unit by loosening two screws in the case of the Adapter 

Base for 6-ml scale. 

2. Take out Reagents Rack from Reagent Unit. 

3. Close the Safety Cover of the Instrument. 

4. Select Unit Cover Movement in the Option menu. 

5. Click Removal of the Reagent Unit in the Unit Cover Movement window and have the Unit Cover lift.  Do the 

same for the Reaction Unit. 

6. Open the Safety Cover of the Instrument. 

7. Remove the Reagent Unit Cover and Reaction Unit Cover by loosening the screws. 

8. Wipe the following accessories with a paper towel infiltrated by 70% ethanol: Reagent Unit Cover (inside), 

Reagent Rack, Reaction Unit Inner Cover, Reaction Adapter Cover, Reaction Adapter Base, Reagent Unit 

(inside), Reaction Unit (inside), and the work area. 

9. Replace Reagent Unit Cover and Reaction Unit Cover and turn the screws on the covers to fasten them. 

10. Close the Safety Cover of the Instrument. 

11. Select Unit Cover Movement in the Option menu. 

12. Click Removal of the Reagent Unit in the Unit Cover Movement window to lift the Reaction Unit Cover to 

dry the Unit.  Do the same for the Reaction Unit. 

13. Close the Unit Cover Movement window. 

 

 

Waste bottle 
 

1. Empty the waste liquid bottle and wash it with water and dry it. 

2. Replace the bottle in the Instrument. 

 

 

Dust box 
 

1. Open the dust box container door. 

2. Take out the box and empty it. 

3. Wash the box and dry it. 

4. Replace the box in the Instrument. 
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4-3.  Shut down the system 
 

1. Select Close in the File menu to close the protocol.  If Protocol Save Message window is displayed, click Yes to save 

it if necessary. 

2. Select Exit in File menu.  Application End Message window will be displayed. 

 

 

 

 

 

 

 

 

3. Click Yes to exit the application. 

4. Shut down the control PC. 

5. Turn off the Instrument. 
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5.  Trouble Shooting 

 

When an error occurs in the Instrument, it will send a beep and the Functional Error window will be displayed on the 

screen of the control PC.  The content of the error and remedial instruction are described in the Functional Error window.  

Follow the instruction to correct the error.  If you could not correct it, contact our technical service with following 

information. 

 

1. Error number displayed in the Functional Error window 

2. Log data of the Instrument.  The log data is contained in following folder of the PC: 

      My computer\\C drive of hard disc\\Protemist DT II\\LOG 

Find the folder of the newest date in the LOG folder, open it, and send us all the files in it. 

3. The protocol file that was being used 

4. Step number of the protocol at the time of the error 

5. Recurrence and frequency of the recurrence of the error 

6. Circumstances when the error occurred 

7. Version of the software displayed at the top left corner in the application window 

8. Serial number of the Instrument on the label attached to the back of the Instrument 

 

 

 

5-1.  Example of the Functional Error window 
 

When an error occurs, Functional Error window will be displayed.  Follow the remedial instruction described in the 

display.  If the same error occurs after following the instruction, contact our technical service.  An example of the 

Functional Error window is shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

To correct the error in the above example, select Unit Cover Movement from Option menu, click Open of the Reaction 

Unit in Unit Cover Movement window to open the Cover, open the Safety Cover, place a Reaction Cup or Cups in the 

right place(s).  After closing the Safety Cover, close the Unit Cover Movement window, click on Retry button in the 

Functional Error window to restart the process. 

[Retry] button:  Restart the process. 

[End] button:  Terminate the process. 

[Mute] button:  Mute beep sound. 

 

Error number and error message title. 

 

The content of the error and the 

remedial instruction are described in 

this field. 
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5-2.  Trouble not accompanied by an error message 
 

Some trouble does not prompt any error message.  When such troubles as shown in the table below occur during the 

operation of the Instrument, try the remedies described in the table.  If the same trouble persists, contact our technical 

service. 

Note: If the battery of the PC becomes empty because of power failure or other causes, error message is not displayed.  

In this case, follow the procedure in Section 5-3. 

 

Trouble Possible Cause Remedies 

No working sound from the 

Instrument when the Instrument 

is turned on. 

 

Power indicator lamp in front of 

the Instrument does not turn on 

when the Instrument is turned on. 

The power cable is not connected normally. Confirm that the power cable is 

connected to the power socket on 

the rear panel of the Instrument 

and the other end of the cable is 

plugged into the wall outlet. 

Circuit breaker of the power source side 

has shut off the power. 

Check the breaker. 

The power fuse in the Instrument is blown. Contact our technical service. 

Abnormal sound, e.g. loud sound. Obstacles in the work area or the fan is 

jammed. 

Turn off the Instrument and 

contact our technical service. 

The software becomes frozen. Communication between the Instrument 

and the control PC is broken. 

 

An application software other than 

Protemist DT II application is started. 

 

An external device is connected to the PC. 

Refer to Section 5-3. 

 

 

 

5-3.  Communication error between the Instrument and the PC 
 

When an error occurs in the communication between the Instrument and the PC, follow the procedure described below 

whether the Functional Error window is displayed or not.  If the same error persists, contact our technical service. 

 

1. Confirm that the connection between the Instrument and the PC is secured. 

2. Turn off and then turn on the Instrument. 

3. Restart the PC.  If the software is frozen, press Ctrl, Alt, and Del keys of the PC simultaneously to restart 

Windows XP. 

4. After starting Windows XP, double click Protemist DT II icon on the screen to start the software.  Notification 

of Abnormal End window is usually displayed. 
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5. Click OK in the Notification of Abnormal End window.  User Diagnosis Message window will be displayed. 

6. Click OK in the User Diagnosis Message window. 

7. Select User Diagnosis from Option menu.  User Diagnosis window is displayed. 

8. Click OK to begin self diagnosis. 

9. Click OK in the window after finishing self diagnosis without trouble. 
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6.  Appendix 

 

 

6-1.  Product-related information 
 

All proteins made using our products are for research purpose only; not for use in diagnostic testing and use in human. 

Contact us for more information and help on the use of our products. 

 

 

6-2.  Intellectual property rights 
 

Our ENDEXT® technologies are covered by US Patent Nos. 6905843, 6869774 and 7919597, and other pending or 

equivalent patents. 

 

 

6-3.  Trademarks 
 

Company names and product names in this manual are trademarks and registered trademarks of companies. 

Protemist, ENDEXT, WEPRO, and SUB-AMIX are registered trademarks of CellFree Sciences Co., Ltd.. 

 

 

6-4.  Contact us 
 

Technical Support 

E-mail: tech-sales@cfsciences.com 

 

CellFree Sciences Co., Ltd. 

Yokohama Bio Industry Center 

1-6 Suehiro-cho, Tsurumi-ku, Yokohama, 

Kanagawa 230-0045 

JAPAN 

Tel: +81-45-345-2625 

Fax: +81-45-345-2626 

Web site: http://www.cfsciences.com 
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